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9. 양면 코팅( MULTICOAT ) 

1) Stack

양면에 코팅 필요한 경우 사용하는 기능

■ 설계 (예 )

1) 상기와 같은 조건으로 코팅 설계 파일을 Formula 기능(P.47)을
이용하여 각각 만든 후 파일 메뉴에서 “New”>”Stack”, 
아래와 같이 해당 컬럼에 마우스로 클릭하여 작성 합니다.
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2) Plot 하면 다음과 같이 나타나면, 

3) Refinement > Target 에서 600~1000에 투과율 100% 하여
“Generate”한 후 “”Simplex”로 Refinement를 합니다. 

4)세로 축에 마우스 왼쪽 버튼을
더블 클릭 하여 Plot 모드를 변
하면 옆 그림으로 됩니다.

목표 값
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이종(2개 이상)의 필터로 Stack 구조와는 달리 경계 면에 입사 각(Angle)이

다르고 면이 평행 하지 않은 구조의 멀티 코팅에 대해 각각 계산하여

전체 시스템에서의 광 특성을 계산하며 특히, 프리즘이나 여러개의 경계면을

빛이 통과하는 경우, 그리고 수직입사가 아닌 경사 입사로 들어와서

여러 경계면을 반사 혹은 투과 하여 진행하는 빛에 대한 특성을 계산하는데

사용하는 Option 입니다.( Stack은 기본 제공 ) 

2) vStack

메뉴 바에서 File ≫ New ≫vStack 선택
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16 vSTACK 
16.1 vStack Fundamentals 

vStack is the tool that calculates the properties of assemblies of coatings and substrates where 
the substrates are not necessarily parallel-sided. The system of elements is known as a vStack 
and it consists of a series of Surfaces. Each surface may be uncoated or it may carry one optical 
coating. When there is only one surface then the system will appear exactly as a single coating 
on an infinite substrate but usually there will be a number of surfaces with associated coatings. 
vStack assumes that all beam directions and surface normals are coplanar. 

The calculations performed by vStack apply to the path of a single beam through the 
assembly. This is in contrast to the Stack system where multiple reflections may be taken into 
account. The path of the beam is defined by the list of surfaces. The terms incident and emergent 
can be confusing since the surfaces may operate in transmission or reflection and the beams may 
not emerge in what has been called the emergent medium. We therefore use the terms front 
material and back material to refer to the two media on either side of each surface. The light is 
incident in the front material. 

The beam is considered to pass from one surface to another without loss. No allowance is 
made for absorption in the media between surfaces. Thus the distance between surfaces is not 
specified. Absorption in the coatings is, of course, included. 

First of all we need to define the conventions used in laying out the system. 
In order to help in this there is a tool that draws a representation of the layout. This tool is 

activated by the Draw Layout item in the Tools menu. 
The beam path in vStack is confined to a plane and all angles are defined in that plane. The s-

direction for polarization-sensitive calculations is considered to be out of the plane towards the 
user. p, s and the beam direction are then defined as a right-handed set in that order. 

Reference direction

Beam angle

Beam
direction

Beam
start

Beam

Reference direction

Beam angle

Beam
direction

Beam
start

Beam

 

Figure 16-1. The Draw Layout tool uses the symbol on the right to indicate the initial beam direction. The 
Reference Direction is always horizontal and the beam angle is measured from it using the usual convention 
for positive and negative angles. 

We start with a reference direction. This is the datum for all angular definitions. The reference 
direction is horizontal and pointing to the right, just like the x-axis of a normal coordinate 
system. All directions are defined in terms of the angle made with that reference. The angle is 
positive if rotated counter-clockwise. That is, the normal definition for positive angles is used. 
Figure 16-1 shows the definition of the Beam Angle together with, on the right, the 
representation of the beam used in the layout tool. When the beam angle is zero, the beam is 
along the reference direction. In the layout, the starting point for the beam is shown as a black 
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dot. The user simply has to define the initial beam angle. All the subsequent beam angles are 
automatically calculated. To see the calculated angles select Display Setup in the File menu and 
check Beam Angle Data. 

Surface orientation is defined with respect to the normal to the surface. The side of incidence 
is called Front and the other side, Back. The normal to the surface is considered to be drawn with 
direction into the surface. That is, the direction of the normal is from the incident, or front 
medium to the back medium. Figure 16-2 illustrates the definition of the Surface Angle. The 
symbol used for the surface in the layout is shown on the right-hand side. The normal is 
indicated by a line drawn into the surface. This line must be on the front or incident side in the 
layout, otherwise an error will occur because the light will not be able to reach the surface. The 
system is defined by the various surface angles. They should not subsequently be changed unless 
the system is changed. 
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Figure 16-2. The definition of the Surface Angle with respect to the Reference Direction is illustrated on the 
left and the representation of the surface and its normal in the Draw Layout tool on the right. 

The beam angle is then used to define the orientation of the input beam with respect to the 
system. Angles of incidence at the various surfaces will automatically be computed. 

The materials on either side of the surface must be defined by the user. The material on the 
side of incidence is called the Front Material. The material on the back medium side is called the 
Back Material. If the light is reflected it will not actually enter the back material. 

Each surface may carry an optical coating. The coating is considered to separate the front 
material from the back material. The coating is defined in a design document, but the incident 
medium for the vStack calculation becomes the front material defined in vStack and the substrate 
for the calculation becomes the back material in vStack. The design document will have its own 
incident material and substrate and the appropriate order of the defined layers. This layer order is 
important. If the layer order in the design document corresponds to the new vStack definitions of 
incident medium and substrate, then the coating will be labeled with the Coating Direction 
attribute Forward. However, should the order of layers in the design document correspond to an 
inversion of the vStack material order then the coating direction attribute should be Reverse. 

The order of the surfaces in the vStack document must be the order in which the light reaches 
them. The user is responsible for ensuring that the order in the document is correct. Each surface 
is considered large enough to intercept the entire beam. The only error that will be detected by 
the software will be an orientation error so severe that the light is incident on the back medium 
side. The calculation will take each surface strictly in turn, even though in the actual system such 
a surface order might be impossible. 
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An attribute that must be defined for each surface is its Transfer Mode. The complete list of 
possibilities with their definitions is in the following table. 
 

Transmit 
Reflect 

These are the usual surface calculations. Transmit includes refraction 
and Reflect follows the law of reflection. Any calculations involving 
irradiances assume that the receiver is larger than the beam so that total 
beam power is measured.  

Perfect Reflect 
The surface has 100% reflectance with no influence on polarization 
except to introduce the usual parity shift. the direction of the reflected 
beam follows the normal law of reflection. 

Rotate 0 
This transfer mode has no effect on beam direction or on any other 
beam attributes. An important use is as a place holder for other Rotate 
modes avoiding having to delete a row when a rotation is removed. 

Rotate 90 Rotates the polarization through 90°. The rotation is positive around the 
beam direction. 

Rotate 180 Rotates the polarization through 180°. 

Rotate –90 Rotates the polarization through -90°. 

Perfect Retro 
This reverses the direction of the beam so that it returns along the input 
path. It includes a parity change but otherwise has no effect on either 
power or polarization. 

 

16.2 A Simple System – Right-Angle Prism 
We illustrate the process by setting up a system consisting of a right-angled isosceles prism, 

Figure 16-3. The hypotenuse is uncoated and relies on total internal reflection. The entrance and 
exit surfaces of the prism have antireflection coatings. The first antireflection coating has air as 
incident medium and glass as substrate. This will usually be the way in which the coating is 
defined in the design document and so its attribute will usually be Forward. If the same coating is 
then used on the exit surface its attribute will need to be Reverse. 

There are three surfaces and, therefore, three elements in the vStack document. The surface 
angles are shown in Figure 16-4. 

These are then entered in the vStack document as shown and the antireflection coatings are 
added to the two surfaces. The second antireflection coating is flagged as Reverse. The Beam 
Angle is set, initially, as 0°. 

The Draw Layout tool output is shown in Figure 16-5 and confirms that the layout in the 
document is what we require. 

A quite useful feature is the display of the orientation angles in the vStack document. To 
activate this feature use Display Setup… in the File menu and check the Beam Angle Data box. 
This information is shown in Figure 16-6. 
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Figure 16-3. A right-angled isosceles prism with antireflection coatings on entrance and exit surfaces and 
total internal reflection at the hypotenuse. 
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Figure 16-4. The various surface angles for the surfaces that will be entered in vStack. 

 

Figure 16-5. The various surfaces as they appear in the output from the Draw Layout tool. The direction of 
the light is from the black dot that indicates the beam start encountering the various surfaces in the order in 
which they are given in the vStack document. 
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Figure 16-6. The vStack document containing the details of the reflecting prism. The antireflection coating is 
the three-layer quarter-half-quarter coating from the Tour of the Essential Macleod chapter. 

The performance can now be calculated as a function of wavelength, frequency or beam 
angle. For increasing positive beam angles the total internal reflection condition will fail at a 
certain point because the incidence on the hypotenuse will no longer be beyond critical, Figure 
16-7. This appears as a catastrophic drop in system throughput. The effect of a thick silver 
coating on the hypotenuse can be readily modeled by replacing the back material Air by Ag. It is 
not necessary, in this case, to add a coating design file. 

 

Figure 16-7. The throughput of the vStack as a function of beam angle at 510nm. The prism depends on total 
internal reflection and as the beam angle increases the incidence on the hypotenuse becomes less than critical 
and much of the light leaks through. 

 

16.3 A Pentaprism 
Now for a more complicated example we consider a pentaprism. This is a device for turning a 

light beam through 90° by a double reflection and, therefore, no change in parity. There are five 
surfaces on the prism but only four take part in the optical behavior. The fifth surface is normally 
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left unpolished. Because the angles of incidence on the reflecting surfaces are below critical, they 
must be coated. this is usually a simple aluminum or silver coating, Figure 16-8 
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Figure 16-8. The pentaprism. Note the coatings on the reflecting surfaces, necessary because the angle of 
incidence is below critical. The drawing on the right shows the surface angles. 

The calculated surface angles are shown in Figure 16-8. We use those to set up the four-
element vStack. 

Now we can enter the details into a vStack document,  

 

Figure 16-9. The entries in the vStack document. Again we are using the antireflection coating designed in 
the Tour of the Essential Macleod chapter. 

With a beam angle of 0° the layout, Figure 16-10, confirms that the entered angles are correct. 
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Figure 16-10. The Draw Layout tool confirms that the surface angles entered into vStack are correct. 

The calculation of throughput, Figure 16-11, shows the difference between an aluminum and 
silver coating on the reflecting surfaces. Note the small degree of polarization sensitivity. 

 

Figure 16-11. The throughput of the pentaprism with reflecting coatings consisting of silver and aluminum. 
There is some polarization sensitivity. By varying the beam angle we can confirm that the polarization 
sensitivity increases slightly with beam angle. 

It is possible to examine the variation of throughput as a function of beam angle. The beam 
angle can be varied from -90° to 90° and an output curve will be drawn. However, the 
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pentaprism is subject to quite severe vignetting as shown in Figure 16-12. This shows the 
unfolded prism and some of the ray paths through it. For a ray that enters the center of the input 
surface, the maximum allowable angle in the glass is 10.5° translating to around 16° in air. 
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2
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Figure 16-12. Vignetting in the pentaprism. If the beam is incident centrally on the input surface then the 
maximum semiangle that will be accepted by the system is 10.5°, measured inside the glass. This vignetting 
is not detected by vStack. 

16.4 Dichroic Color-Separation Prism 
Finally let us look at a dichroic color separating prism. This will split the visible region into 

red, green and blue light and we will need some preliminary designs for the coatings. These 
should be fairly good starting designs that we will refine in vStack. Although synthesis is 
available in vStack, the volume of calculation involved in any system of reasonable complexity 
makes the synthesis of coatings from scratch rather slow. If reasonable starting designs are 
known then it is much more efficient that they should be used. 

The arrangement is illustrated in Figure 16-13. The first coating we will make a blue reflector 
and the second a green reflector. The red channel will be transmitted through both dichroic beam 
splitters. We shall also design the assembly purely for s-polarization. This is rather different from 
the various systems we have looked at because there are several different paths through the 
system and all must operate correctly and simultaneously. They are numbered from one to three 
in Figure 16-13. A vStack document defines a single path and so to describe this new system, we 
will need three vStack documents. We shall call them Path 1, corresponding to blue, Path 2, 
corresponding to green and Path 3, corresponding to red. 
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Figure 16-13. A simple dichroic beam splitting prism assembly separating the input into three different 
wavelength regions. 

The surface angles are shown in Figure 16-14. 

0°

90°

45°

-90°

0°

-45°

0°

90°

45°

-90°

0°

-45°

 

Figure 16-14. The various surface angles in the dichroic beam splitting prism assembly. 

Now we need to consider the coatings. The performance of a simple 4-layer antireflection 
coating for the region 400 to 700nm is shown in Figure 16-15. This uses materials Ta2O5 and 
SiO2 and is a refined starting design of Air | L HH 0.1L 0.1H | Glass. For the dichroics, we will 
choose simple quarterwave stacks of 41 layers of Ta2O5 and SiO2: (HL)^20 H. For the blue-
reflecting dichroic we choose a reference wavelength of 510nm and for the green-reflecting, 
570nm. the three vStack documents are shown in Figure 16-16. 
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Figure 16-15. The performance of a simple 4-layer antireflection coating for the visible region. This will be 
used on the input and all output surfaces of the prism assembly. 

Each vStack then requires a set of refinement targets. We can define the response regions as 
405nm to 495nm for blue, 505nm to 595nm for green and 605nm to 695nm for red. Although for 
each channel we require a maximum response within the defined band and a minimum response 
outside it. If all channels exhibit their ideal maximum then the minimum requirements must also 
be satisfied automatically. Thus in the refinement targets we can simply require 100% 
throughput over the appropriate range. The appropriate targets then, are: 

Path 1 

405-495nm step 1nm, 
Beam angle 0° 
100% Throughput, 
Weight 1, 
s-polarization 

Path 2 

505-595nm step 1nm, 
Beam angle 0° 
100% Throughput, 
Weight 1, 
s-polarization 

Path 3 

605-695nm step 1nm, 
Beam angle 0° 
100% Throughput, 
Weight 1, 
s-polarization 

Note that even though the angle of incidence on the dichroics is 45° the setting of Beam Angle is 
zero and the polarization is set as s-polarization. 
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Figure 16-16. The three vStacks, Path 1, Path 2 and Path 3. 

 

Figure 16-17. The Co-refinement dialog where the vStacks to be co-refined with the current one are defined. 

These targets must be simultaneously satisfied and this involves all the coatings. To 
accommodate this type of condition, vStack has the ability of Co-refinement. Co-refinement is a 
technique that permits a number (any number) of vStacks to be simultaneously refined along 
with a principal one. The targets for the co-refinement process is the sum of all the individual 
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targets. To activate co-refinement the vStacks to be co-refined are identified in the co-refinement 
dialog, Figure 16-17. This is opened in the Refinement Parameters submenu by choosing the Co-
refinement item. The principal vStack is simply the one that will be used to launch the 
refinement. All progress plots will be of the principal performance, but the figure of merit that is 
reported and involved in the refinement will be calculated using all targets. 

The starting performances of the various paths are shown together in Figure 16-18. 

 

Figure 16-18. The unrefined performance of the three paths through the prism assembly. The large ripple 
complicates the figure enormously and makes it difficult to interpret. 

In this particular case, where we have good starting designs, Simplex is the most efficient 
technique. The parameters we use are in Figure 16-19. 

Refinement yields the performance shown in Figure 16-20. 
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Figure 16-19. The parameters used in Simplex. 

 

Figure 16-20. The final performance of the three channels after refinement. 

16.5 Polarization Leakage 
In many dichroic splitters and combiners, polarization preservation is important. The transport 

of energy demands apertures greater than zero, implying a collection of angles of incidence that 
can conveniently be thought of as a bundle of rays forming a cone around the direction of the 
principal ray. The polarization of the cone will be defined as either p-polarization or s-
polarization with respect to the principal ray. But the p- and s-performance of the coating is tied 
to the local plane of incidence, and so those rays that are skewed with respect to the principal 
plane of incidence will exhibit what is termed polarization leakage. Some of the s-polarized light 
in the cone will leak into the p-direction and vice versa. For small skew angles, the leakage will 
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be proportional to the square of the skew angle. Polarization leakage is therefore calculated in 
units of ppm/(degree)2. Polarization leakage is particularly important in systems involving liquid 
crystal light valves that operate by altering the polarization state of the light. Image projectors are 
an important class of such instruments. There is nothing that can be done to alter the polarization 
leakage in a single tilted element. However, in some systems containing multiple elements, it is 
possible to arrange the design to reduce the extent of polarization leakage and so polarization 
leakage is a refinable parameter. Essentially the refinement process is actually altering the 
relative retardation through the system. This is normally neglected in a system where simple 
throughput is the design parameter. 

To convert the polarization leakage coefficient into total leakage in a cone of semiangle Φ 
(degree) we use the expression: 

 2

4
Total leakage γ= Φ  (16.1) 

where γ is the leakage coefficient. The result will be in parts per million and should be multiplies 
by 10000 to convert to per cent. In most cases this expression will be sufficiently accurate up to 
cone semi-angles of ten degree or so. 

16.6 Wavefront Errors - Phase 
To facilitate the calculation of wavefront errors, Phase, is included in the list of calculable 

parameters. This is the cumulative change in phase of the ray that can be attributed solely to the 
coatings. It does not include any phase change due to the traversal of the space between 
successive coatings. The change in phase can be associated with such as changes in beam angle 
or uniformity errors. A regular change in phase with angle indicates a tilted wavefront. One full 
wavelength is indicated by 360°. Such errors would be important only in very highly corrected 
systems. Errors in uniformity are more important. In order to assess the problems of uniformity 
errors we need two coating designs, one represents the perturbed coating and the other the ideal 
reference. Provided the order of layers in the design files are such that the substrate is the true 
coating substrate on which it is deposited, then the thinner of the two coatings should have 
sufficient front material added to its medium side to make the total physical thicknesses of the 
two coatings identical. Of course, if the coatings are used in the reverse mode, then back material 
should be added. This is to ensure that the path between the coatings in the system is identical in 
both cases. Comparison of the phases calculated with reference coating and with perturbed 
coating will yield an estimate of the wavefront error. Again, 360° represents one wavelength. 
Phase is wrapped to a principal range that is automatically -180° to +180° but can be manually 
altered. 

16.7 Other Parameters 
Other parameters that can be calculated include the dispersive terms, Group Delay, Group 

Delay Dispersion etc, the ellipsometric parameters psi and delta, and the exit beam angle 
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